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Major new features and enhancements  

This section describes the main new features in Phast v7.0. 

An intuitive and flexible new interface 

The most obvious new feature in v7.0 is the new design for the user interface. Most of the options 

from the previous version are still present, but in a different form or location, and some new options 

have been added. 

 

The program has a Ribbon bar instead of menus 

The program follows the approach of modern Windows programs such as the Microsoft Office 

programs, where commands are presented in a large icon-based toolbar that can always be visible, 

instead of in text-based menus that are always hidden when not in use. 

The Ribbon bar has several tabs. Some of these tabs are always present, whereas others only appear 

when you are working in a particular part of the program. In the illustration above, a Graphs View is 

being used, and the three tabs of the Graph Tools group have been added to the Ribbon bar. 

The Home tab contains the most common commands, for working with nodes in the Study Tree, for 

running calculations, and for viewing Reports, Graphs and GIS Results (i.e. effect zones shown on a 

map). 

Note: the Ribbon bar does not include any options for inserting nodes into the Study Tree. To insert a 

node into the Study Tree in v7.0, you use the Insert option in the right-click menu. 

For further details in the Help: In the Index tab, enter “Ribbon bar”. The Help gives a full 

description of the options in each tab of the Ribbon bar, and also 

guidance on techniques for working with the Ribbon bar. 

To open the Help window, click on the Show Help button in the Help tab of the Ribbon Bar, 

or click on the Help button in an input dialog. 
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The elements of the program window are easier to organize and control 

There are various panes and windows used in the program, and the general term for these panes and 

window is View. With the new interface, there are many options available for arranging the Views to 

make them easier to work with for your current task. 

The general default arrangements of the elements is the same as in the previous version, with the 

Study Tree (for input data) along the left of the window, the Output View (for messages) along the 

bottom, and with GIS Views, Reports and Graphs (known as Document Views) shown in the display 

area at the centre of the window. However, Document Views are now presented in a way that makes 

them easier to navigate, with each View presented in its own tab within the display area, so that you 

can see from the tab headers which Views are currently open, and move between them easily. In the 

illustration above, the four Document Views that are open in the display area can easily be identified 

from their tab headers: the GIS Input View, the Grid View, a Report View for a 25 mm leak, and a 

Graph View for the 25 mm leak. The Grid View is a new type of data-input tool, which is described in 

a later section. 

If this default arrangement is not suitable for your current task, you 

can change the arrangement by dragging Views to different 

locations. To move a particular View, drag it by its tab header or 

title bar. When you are dragging a View, a cross-shaped control 

will appear over the window, as shown in the illustration, and you 

release the cursor in a particular area of the control to place the 
View in a particular relation to other Views. 

The details of the control depend on the type of View that you are 

dragging. The illustrations shows the form of the control when you 

are dragging a Document View (e.g. a Report). If you release the 

cursor in one of the four outer areas in the control - the New Group 

options - then the program will create a new Document View group 

on the other side of the current group in the direction corresponding 

to the area that you chose, and it will move the current View to this 

new group. You would use this option to be able to see two Reports side-by-side, for example. 

The area in the centre of the control shows a group with multiple Views in it, shown by the tab headers 

for the different Views. This is the Add to Group option, and if you have more than one group and you 

want to move a particular View to a different group, you should drag the View into the other group 

and select the Add to Group option in the control for that group. You would use this option if you no 

longer wanted to see two Reports side-by-side, and wanted to place them back in the same group. 

The options in the controls can become complicated, depending on the current arrangement of groups 

and on the type of View that is under the cursor at a given time. The best way to learn how to use them 

is by experimentation. If you choose the wrong control and the View does not appear as you wanted it, 

you can simply move the View again until you get the correct arrangement. 

The other new option is the Auto Hide option, which appears in the 

Options menu for the Study Tree and for the Output View, as shown. If 

you select this option, then the current group of tabs will automatically 

collapse itself against the side of the main program window whenever you 

move the cursor away from the group. If you move the mouse over one of 

the tab headers in a collapsed group, that View will expand or pop up, and 

you can work in the View. 

For further details in the Help: In the Index tab, enter “Views”. The Help gives a full description 

of the different types of View, and of the various techniques for 

working with them. 
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Better information and control over different types of message 

The Output View is the name in v7.0 

for the View that gives messages 

about operations, e.g. about upgrading 

a file, or running calculations. 

In v7.0, the program uses icons to 

distinguish between Errors, Warnings 

and information Messages, and the toolbar along the top of the View contains buttons that show the 

number of messages of each type currently displayed in the view, e.g. 19 Warnings, in the illustration 

above. 

You can use the buttons that show the number of 

messages to choose whether or not to view a particular 

type of message. By default all three types are displayed, but you can click on the button for a 

type of message to hide those messages. In the illustration, the 19 Messages are hidden, as 

shown by the red bar over the icon. If a type of message is currently hidden, you click on the 

button again to return to showing those messages. 

For further details in the Help: In the Index tab, enter “Output View”. 

Graphs are easier to navigate, read and customise 

There have been several changes to 

the presentation and appearance of 

Graphs, all of which make them 

easier to work with. 

One of the changes is that all 

graphs are now organised into 

groups, where each group covers a 

different category of results, e.g. 
Dispersion, Jet Fire, etc. Each 

group has its own tab header at the 

bottom of the Graphs View, with 

an icon that identifies the type of 

results. Within the tab for a given 

group, there are tab headers for the 

individual Graphs within that 

group. 

The individual Graphs have been made clearer, with a distinction now made between “major” and 

“minor” gridlines. Major gridlines are a solid dark green by default, and have the numeric value shown 

on the axis, whereas minor gridlines are a dotted light green, and have a marker on the axis but no 

value. Major gridlines appear at standard locations depending on the scale of the Graph (e.g. factors of 

1, 5, 10, 20, etc.), which makes the scale clear and makes different Graphs easier to compare. 

The three Graph Tools tabs of 

the Ribbon Bar allow you to 

change the appearance of an 

individual Graph and to 

choose the details of the results 

you want to view. The 

Configuration tab allows you to control almost every aspect of the appearance, such as the text and 

font for titles, the minimum and maximum values for each axis, the style of major and minor gridlines, 

the style of lines (or “Series”), and the position of the legend. 

For further details in the Help: In the Index tab, enter “Graphs”. 
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Input data reorganised to improve sharing and visibility 

If you open a *.psu file for an analysis created in v6.7 of the program, you will see another obvious 

difference between v7.0 and previous versions, because the structure of the input data nodes in the 

Study Tree will not be the same as the structure that you set up in the earlier version. You may see 

changes in every tab of the Study Tree, depending on the details of the values in the *.psu file. 

Hazardous events are now defined by Scenarios for specific Equipment items 

In the Models tab, each hazardous event for modelling is now 

defined as a combination of an Equipment item and a particular 

type of event Scenario, and a given Equipment item may have 

any number of different Scenarios defined underneath it. 

In the illustration, the LPG sphere 101 node is a Pressure Vessel 

Equipment item, and there are four Scenarios defined underneath 

it: one Catastrophic rupture, and three Leak Scenarios, each 

modelling a different hole size. Different types of Scenarios have 

different icons in the tree, so you can see at a glance what type of 

Scenarios have been defined for a particular Equipment item. 

You define the release material, the inventory, the storage or 

operating conditions and the geographical location at the 

Equipment item level, which means that all Scenarios under the 

item share that data, and you do not have to repeat the input data 

for the individual Scenarios. You can also set values at the 

Equipment level that you want to be used as default values by the 

Scenarios under the Equipment. This makes the data easier to 

enter and to maintain. 

There are three types of Equipment item: 

• Pressure Vessels  

For modelling different types of release from pressurised containment. 

• Atmospheric Storage Tanks  

For modelling different types of release from unpressurised containment. 

• Standalones  

Not available in Phast Lite 

For detailed modelling of fire, explosion and pool vaporisation, separate from the modelling 

of a particular release from containment. The list of Scenarios available for a Standalones 

Equipment item is the same as the list of standalone Models in earlier versions. 

Pressure Vessels and Atmospheric Storage Tanks are known as 

“storage” Equipment items. The illustration shows the right-click 

Insert options for a Pressure Vessel in Phast, and all of the 
Scenarios that are available for a Pressure Vessel are also 

available for an Atmospheric Storage Tank. 

Most of the Scenarios are equivalents of options in the Scenario 

tab section for a Vessel/Pipe Source Model in previous versions, 

with the Short Pipe Scenario covering the Line Rupture, Disc Rupture and Relief Valve options. 

Note: the Time varying and User defined source Scenarios are not available in Phast Lite. 

The details of the process of upgrading a v6.7 *.psu file are given at the end of this section. 

Note: the Input Report for a Scenario will include data for the Scenario’s Equipment item. 

For further details in the Help: In the Index tab, enter “Equipment items” or “Scenarios”. 
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Bund, building and surface-roughness data now defined on Map tab instead 

of in data for Models or Weathers 

Some types of input data that were defined in the dialogs for individual 

Models or Weathers are now defined on the Map tab in the Study Tree, 

where there are three new types of node: 

Bund Type data  

The data for a Bund Type are used in the modelling of pool spreading 

and vaporisation. The data include the height and diameter of the bund 

and the type of surface on which the pool will spread. 

In previous versions of the program, this information was entered 
directly in the dialog for a Source Model or standalone Pool 

Vaporisation Model. 

Each new workspace is created with a Bund Type called No Bund, which 

has the area of the bund set to zero and the evaporation surface set to 

concrete. This is the same as the default settings for the bund fields in the Model dialogs in previous 

versions. 

Building Type data  

The data for a Building Type are used for a storage Scenario in the modelling of concentration build-

up within the building in which the material is released, and also for the modelling of toxic effects for 

people indoors, in the path of a dispersing toxic cloud. 

The Building Type dialog contains the input fields for both types of calculation. The data for 

concentration build-up deal with the dimensions of the building and the ventilation data, and the data 

for toxic modelling deal with ventilation and evacuation. The fields are entirely separate for the two 

types of calculation, and none of the inputs that are used in one type are used in the other type. This 

means that you should not think of a Building Type as being a description of a single specific building, 

but instead should think of it as a description of a pair of buildings that are convenient for you to 

define together: a building in which a release can take place (e.g. part of a process plant); and a 

building that a toxic cloud can enter from outside (e.g. a representative house along the path of the 

cloud). 

In previous versions of the program, this information was entered directly in the dialog for a Source 

Model. 

Each new workspace is created with a Building Type called Building Type, which has the dimensions of 

the building set to 4 m height, 5 m width and 10 m length, and the ventilation and evacuation data set 

to the default values used in the Model dialog in previous versions. 

Terrain Type data  

The data for a Terrain Type are used in the modelling of dispersion and pools for a storage Scenario. 

This includes the roughness of the surrounding terrain, and whether the surface is land or water. 

In previous versions of the program, the roughness was set in the dialog for an individual Weather so 

might be different between different Weathers, and the nature of the surface was set in the Dispersion 

Parameters. 

Each new workspace is created with a Terrain Type called Default Terrain, which has the dispersing 

surface type set to “Land” and the surface roughness length set to 18 cm, which is associated with 

terrain with medium-height crops and with occasional large obstacles. This is the same as the default 

settings for the fields in the Weather and Parameter dialogs in previous versions. 

For further details in the Help: In the Index tab, enter “Bund Type” or “Building Type” or 

“Terrain Type”. 
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Having the data defined in the Map tab allows you to share the values between different Scenarios, 

making the data easier to enter and maintain, and also making the design of the analysis clearer. 

The input dialog for a storage Scenario includes a 

Bund, building and terrain tab section, as shown 

in the illustration. All of the fields in this tab 

section take their default values from the 

Equipment item and the Equipment item takes 

default values from the Study, which makes it easy 

to control and vary the values used in different 

parts of the analysis. 

The Terrain Type and Bund Type that are selected 

in this tab section will be used in the calculations 

for the Scenario. 

If you want to model the concentration build-up 

within the building in which the release occurs, 

check the box for Specify the release building 

type. The Building Type selected will be used in 

the build-up calculations. 

The input dialog for a storage Scenario also 

includes a Toxic parameters tab section, as shown. 

If you want to model the toxic effects on people 

indoors in the path of the dispersing cloud, check 

the box for Specify the downwind building, and 

then select the Building Type from the list. 

 

Weather and Parameters Sets no longer have a hierarchy of Global and Local 

data 

Not applicable to Phast Lite 

In previous versions, each Study Folder had a set of Weathers called the Global Weathers, and a set of 
Parameters called the Global Parameters. Nodes for Studies appeared in the Weather and Parameters 

tabs in the Study Tree, and you could insert Weather and Parameters nodes under the nodes for a given 

Study, to be “local” to that Study. The calculations for Models under a Study would be run for all 

Global Weathers and also any Local Weathers, using the values for Local Parameters, which took 

default values from the Global Parameters. 

In v7.0, there are no nodes for Studies in the 

Weather and Parameters tabs in the Study 

Tree, and you do not set up Weathers or 

Parameters to be specific to a particular 

Study. Instead, you can set up any number of 

Weather Folders and Parameter Sets, and 

then use the Context of calculations tab in the 

dialog for a Study to select the Weather 

Folder and Parameter Set to use in the 

calculations for the Scenarios in that Study. 

All Parameter Sets take their default values from the System Parameters, which you cannot edit within 

the program. No Set within a workspace will take default values from any other Set within the 

workspace, i.e. there is no longer any hierarchy of Parameter Sets inside a workspace. 
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The Active Study: controls the Parameter Set used 

when editing in Weather and Map tabs 

Not applicable to Phast Lite 

When you are editing an Equipment item or a Scenario in the Models tab section of the Study Tree, 

the values shown for defaulted fields will be taken from the Parameter Set selected for the Study to 

which the item or Scenario belongs. However, other tab sections of the Study Tree do not include 

Study nodes, and when you are editing a node in the Weather or Map tab sections, the values shown 

for defaulted fields will be taken from the Parameter Set that is selected for the Active Study. 

The Active Study field in the Home tab of the Ribbon Bar lists all of the Studies that are defined in 

the Models tab of the workspace. When you select a particular Study as the Active Study, the 

Parameters Set that is selected in the Context of calculations tab for that Study will be used in the 

editing process for any node outside the Models tab. 

The upgrade process for v6.7 *.psu files 

Important Note: you can only upgrade *.psu files and only from v6.7. If you try to open a *.psu file 

from a version before v6.7, the program will display a message telling you that it cannot be opened in 

v7.0, and telling you to open and save it in v6.7 so that you can then open it in 7.0. 

If you try to open a *.psc compressed file, the program will tell you that it cannot be opened in v7.0. 

You should open it in v6.7 and save it as a *.psu file. 

The following changes will be made when you upgrade a *.psu file from v6.7: 

Model nodes converted to an Equipment item node and a Scenario node 

Each Source Model node will be converted into either a Pressure Vessel or Atmospheric Storage Tank 

Equipment item, depending on the storage conditions, with a Scenario node of the appropriate type 

underneath. 

Each standalone Pool Vaporisation Model will be converted into an Atmospheric Storage Tank 

Equipment item with a Spill Scenario underneath it. The Spill Scenario is a new type of storage 

Scenario, described further in a later section. 

Each standalone fire or explosion Model will be converted into a Standalones Equipment item with a 

Scenario node of the appropriate type underneath. 

Some Models in the *.psu file may have identical values at the Equipment item level, as they represent 

different types of hazardous event involving the same piece of equipment. The upgrade process does 

not attempt to identify such Models and place all of their Scenarios under the same Equipment item 

node, but will always create a separate Equipment item for each Model. After the upgrade you should 

review the Equipment item data, and move all Scenarios that have the same Equipment item values 

under a single Equipment item node. This will make the design of the analysis clearer, and the data 

easier to maintain. 

Note: Some Models that were treated as complete in v6.7 may be shown as incomplete on upgrade in 

v7.0 because the checks are more rigorous. For example, a fixed duration release from atmospheric 

storage would be shown as complete in v6.7 if no tank head was defined, but in v7.0 is will be 

upgraded as incomplete, and you must set the tank head in order to run the calculations. 

Non-default bund, building and terrain values converted to Type nodes in the Map tab 

For each Source Model or standalone Pool Vaporisation Model that has non-default values for the 

bund data, the program will create a separate Bund Type node in the Map tab, naming the node after 

the Model, and it will select this Bund Type in the Bund, building and terrain tab for the Equipment 

item dialog for the upgraded Model. 
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For each Source Model that has non-default values for the building data, the program will create a 

separate Building Type node in the Map tab, naming the node after the Model, and it will select this 

Building Type in the Bund, building and terrain tab for the Equipment item dialog for the upgraded 

Model. 

For each Weather that has non-default values for the surface roughness, the program will create a 

separate Terrain Type node in the Map tab, naming the node after the Weather. It will not select this 

Terrain Type for any Study, Equipment item or Scenario, and you will get different results for these 

Weathers if you run the calculations in the as-upgraded state, as the calculations will be using the 

surface roughness values for Default Terrain. 

Important Note: the fact that the definition of non-default surface roughness has been moved from the 

Weather node to the Scenario node in v7.0 means that it is not possible to set up a data structure in 

v7.0 that is the exact equivalent of the structure in v6.7 for modelling non-default surface roughness. 

Whenever you upgrade a file, you should check to see whether any non-default Terrain Type nodes 

have been created in the Map tab, and then decide how you want to structure the data in the Models 
tab in order to run Scenarios with non-default Terrain Type data. 

Local Weathers and Parameters converted to separate Weather Folders and Parameter Sets 

If a Study in the *.psu file has any local Weathers defined, the program will create a Weather Folder 

that contains those local Weathers and also all Global Weathers, and it will select this Weather Folder 
in the Context of calculations tab in the dialog for the Study. This means that the set of Weathers run 

for that Study will be the same as in v6.7. 

If a Study in the *.psu file has any local Parameters defined, the program will create a Parameter Set 
with a full set of Parameter nodes, and it will select this Parameter Set in the Context of calculations 

tab in the dialog for the Study. The Parameter Set will take default values from the System Parameters, 

but will use any non-default values that were set in the Global Parameters and Local Parameters in 

v6.7, with the values for the Local Parameters taking precedence. With these settings, the Parameter 

values used in calculations for the Study will be the same as in v6.7. 
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New editor tool for working on data in tabular form 

Not available in Phast Lite 

The Grid View is a new type of window that allows you to view and work on the data for more than 

one item at a time. You can use the Grid View to add items to the data structure (as an alternative to 

using the Study Tree) and you can also paste data from Excel into the Grid View. 

 

Selecting the type of data to display in the Grid View 

The Grid View has two sections - an upper section, and a lower or detailed section - and this means 

that it can display data for more than one type of item at the same time. 

To select the item to display in the upper grid, select the item in the Study Tree. The upper grid 

displays data for only one item at a time. 

To specify the type of object to display in the lower grid, select the 

object-type from the filter list at the left of the toolbar for the lower 

section of the grid. This list will include all types of child objects that 

are valid under the type of object that is currently selected for the 

upper grid (the “parent node”), down to the lowest level of the tree 

structure, whether or not there are objects of that type currently 

present in the tree. The illustration shows the contents of the list when a Pressure Vessel Equipment 

item is selected in the Study Tree; the list shows all the types of Scenario available for a Pressure 

Vessel. 

In the illustration at the top of the section, the Grid Filter has been set to Leak, and the lower section is 

displaying data for three Leak Scenarios. 

Entering data using the Grid View 

You can use the Grid View to enter values for input data, in both the upper and lower sections of the 

Grid. The lower section of the Grid View, in particular, can be a very convenient way of getting an 

overview of the state of the data for multiple items, and for entering large volumes of data quickly. 

You can work with the fields in the Grid View in the same way as with the fields in the dialogs, typing 

values for descriptions and numbers, and selecting options from lists. 

You can also select a range of cells either in Excel or another part of the Grid, copy the data to the 

clipboard and then paste it into the Grid. The program checks the values that are being pasted, and will 

generate a message for any that are not valid, so you can investigate the errors and correct the data and 

paste it again. 
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Adding Scenarios and other items using the Grid View 

You can use the Grid View to add a new item to the analysis, as an alternative to using the Insert 
option in the right-click menu for a node in the Study Tree. 

The two Add buttons at the right of the toolbar in the lower grid will add a single 

item, of the type that is currently selected in the Grid Filter. The Add New button 

will add a new, blank item, whereas the Duplicate button  will create a new item 

as a copy of the item that is currently selected in the lower grid, i.e. the item with a triangle 

icon shown to the far left of the row. The new or duplicate item will be added to the lower section of 

the Grid View and to the Study Tree. The Add New option will add the new item to the tree under the 

first suitable node underneath the selected node (e.g. under the first Pressure Vessel Equipment item, if 

a Study node is selected and you are adding a Leak Scenario), whereas the Duplicate option will add the 

new item to the tree under the same node as the copied item. 

You can also add items by pasting multiple rows of data 
into the lower grid, which gives a very quick way of setting 

up the structure and data for an analysis. When you 

perform this sort of paste operation, a message will appear 

as shown, telling you that you are pasting data outside the 

current limits of the grid, and asking if you want to create 

new items for the additional rows. 

For further details in the Help: In the Index tab, enter “Grid View” for full details of the features 

of the Grid View and the options for working with it. 
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New standalone Pool vaporisation Scenario performs multi-
component modelling of mixtures 

Not applicable to Phast Lite 

If you have a license for the multi-

component modelling of mixtures, 

then the new standalone Pool 

vaporisation Scenario will allow 

you to choose between using 

pseudo-component and multi-

component modelling for the 

behaviour of mixtures. If you do 

not have a license, then the only 

option available for the Multi or 

pseudo-component modelling 
field will be “Pseudo-component”. 

The modelling of pool spreading 

and vaporisation that is performed 

for the storage Scenarios can only 
be performed with pseudo-

component modelling, and if 

multi-component modelling is 

selected for a storage Equipment item, rainout, pool spreading and pool vaporisation will not be 

modelled for any of the Scenarios under the Equipment item. In earlier versions the standalone Pool 

Vaporisation Model performed the same pool vaporisation calculations as the Source Models and did 

not perform multi-component modelling of mixtures, but in v7.0 the old Pool Vaporisation Model has 

been converted into a storage Scenario called the Spill Scenario, and a new Pool Vaporisation 

Scenario has been added which can perform multi-component modelling. 

There are new parameters in 

the Pool vaporisation 

parameters dialog that are 

used in the new standalone 

Scenario, as shown in the 

illustration. 

The Phast 6.7 correlation is 

the same as the correlation 

used in the pool vaporisation 

calculations performed for 

the storage Scenarios. For a 

release involving a single 

component or for a mixture 

being modelled with pseudo-

component modelling, this correlation will give comparable vaporisation results from the standalone 

Pool Vaporisation Scenario and from the equivalent spill modelled for a storage Scenario. The MacKay 
and Matsuga and Opshoor correlations will give different results from those for the equivalent spill for a 

storage Scenario, for the release of a pure component or of a mixture. 

For further details in the Help: In the Index tab, enter “Pool Vaporisation Scenario”. 

For details of the modelling: Refer to the Technical Reference documentation supplied with the 

program. 
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Other enhancements 

More information now available for Graphs that cover multiple 
Scenarios or Weathers 

In previous versions, limitations applied to Graphs that covered multiple Scenarios or Weather, so that 

options that were available for Graphs that covered a single Scenario and Weather were not available 

for such Graphs. These limitations now no longer apply. 

Time-animation is now available 

The Footprint, Side View and Cross Section 
Dispersion Graphs and the Late Explosion at 

Time Graph all display the results at a given 

time after the start of the release, and the tools 

in the Animation tab of the Ribbon Bar allow 

you to activate the dynamic plotting, and view the development of the cloud and effects over time. 

In previous versions, the dynamic plotting was only available for a Graph View that was displaying 

the results for a single Scenario for a single Weather. This limitation no longer applies, and you can 

now view animated results for Graphs that cover multiple Scenarios or multiple Weathers. 

The Graphs can now display results for more than one effect level 

There are many Graphs that show the shape of the contour or footprint for a given effect level, e.g. the 

Cross Section Dispersion Graph, the Radii Graphs for fires, several Explosion Graphs, the Flash Fire 

Graph, and the Toxic Footprint Graphs. In previous versions, a Graph View that was displaying results 

for multiple Scenarios or Weathers would display results for a single effect level at a time, but this 

limitation now longer applies and you can view multiple effect levels for such Graphs. 

A Graph that covers a single Scenario and Weather will display the results for all of the effect levels of 

interest when the Graph View first opens, i.e. the initial state is to display multiple effect levels. 

However, a Graph that covers multiple Scenarios and Weathers will initially display results for a 

single effect level (the lowest effect level of interest), as this makes the Graph easier to read. If you 

want to see results for more than one effect level for such a Graph, you will have to change the options 

for the Graph, and the method of changing the options depends on the type of Graph: 

The Edit Series Properties dialog: for the Graphs with fixed levels of interest 

For some Graphs, the levels of interest are set in the input data for the 

Scenario or parameters. The levels cannot be changed within the 

Graphs View, and if you want to view results for different levels, you 

must change the values in the input data, rerun the Scenario, and open 

a new Graphs View. 

The Graphs with fixed levels of interest are: 

• Early Explosion Radii and Late Explosion Worst Case 

• Intensity Radii for fires 

• Flash Fire 

If you click on the Series… option in the Configuration tab of the 
Ribbon Bar to open the Edit Series Properties dialog for one of these 

Graphs, you will find that there is an entry in the dialog for every 

effect level of interest, for every Scenario and Weather covered by the 

Graph. Only the entries for the lowest level will initially be selected, 

but you can select any number and combination of additional entries. 
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The Edit Settings dialog: for Graphs with editable levels of interest 

For some Graphs, the initial values for the levels of interest are taken from the input data for the 

Scenario or parameters, but you can specify different values while you are working in the Graphs 

View, and the program will update the Graph to display the changed values. 

The Graphs with editable levels of interest are: 

• The Footprint, Side View, Cross Section and Max. Concentration Dispersion Graphs 

• The Late Explosion Distance and Late Explosion Time Graphs 

• The Toxic Footprint Graphs 

For these Graphs, the Edit Settings button will be enabled in the Consequence tab of the Ribbon Bar. 

You use this button to open the Edit Settings dialog, which will contain input fields that allow you to 

change the number of levels to display, and also the values for those levels. The form of the input 

fields depends on the type of Graph: 

For the Dispersion Graphs the primary concentration of 

interest is always enabled. It will initially be set to the 

lowest concentration of interest, and this value sets the 

minimum value that you will be able to set for any of the 

Concentration fields in the dialog. 

The Use boxes for the other three levels will initially be 

unchecked, but you can select any number of these 

additional levels, and enter any concentration value 

greater than the lowest concentration of interest. 

 

For the Explosion and Toxic Graphs the levels of interest 

are presented in the form of a table, with the number of 

rows in the table set by a Number of Levels field. 

The number of levels will initially be set to one, and the 

Level set in the table will be the lowest level of interest 

set in the input data for the Scenario or parameters. 

You can change the value for the Number of Levels, and 

if you then press [Tab] to update the table and increase 

the number of rows, you can set the values for the 

additional levels. You can also change the value for the 

first level. 

 

For further details in the Help: In the Index tab, enter “Graphs” for an overview of working with 

Graphs. 
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Warnings appear when memory or reporting is near limits 

Some operations in the program can take aspects of the computer systems beyond their limits and 

cause the program to crash, which will cause you to lose changes that you have made to the workspace 

since the last time you saved it. 

When you select the option to perform one of these operations, the program now checks if the systems 

are close to their limits, and if they are, it will display a warning dialog that gives you the option to 

cancel the operation. 

Warning about low available memory 

Running calculations and viewing Reports, Graphs and GIS Results can use a lot of computer 

memory.  

Whenever you select one of these operations, the program 

will check the available memory, and if it is low, a 

warning dialog will appear as shown giving suggestions 

for increasing the amount of memory available, and giving 

you the option of cancelling the operation so that you can 

save the workspace file and take actions to reduce the 

memory-use before performing the operation again. Click 

on No or Cancel to cancel the operation. 

If you decide to click on Yes and proceed with the 

operation after receiving this warning, there is a risk that 

the program might run out of memory and crash. 

Warning about reaching the number of activated reports 

A particular report becomes “activated” if the tab for that report has been selected, which means that 

the data for the report are loaded into the tab for display. Whenever you open a Reports View, the first 

tab in that view will automatically be selected and activated, and if you click on other tabs in the view, 

then those reports will become activated. 

The reports in any tabs that you have not clicked on have not been activated, and when you close a 

Reports View, the reports for that view are removed from the list of activated reports. 

The Reports system is limited to having a maximum of sixty 

reports activated at a given time. If you take an action that 

brings you close to this limit (i.e. by clicking on the tab for a 

report, or by opening a new Reports View), a warning dialog 

will appear as shown. Click on No or Cancel to cancel the 

operation and then close Report Views in order to reduce the 

number of activated reports. 

If you decide to click on Yes and proceed with the operation 

after receiving this warning, there is a high risk that the 

Reports system will give errors and cause the program to 

crash. 

For further details in the Help: In the Index tab, enter “warning dialog” for details of the warning 

dialogs and techniques for reducing memory-use. 

Note: You might not always receive a warning when the program is running low on memory, 

depending on the sequence of operations. The program has known issues with memory-management 

that are currently under investigation, but DNV Software has decided to release the program with 

these issues rather than risk a significant delay to the release. You should make a habit of saving 

workspaces regularly, to avoid losing work in the event of running out of memory. You can also 

increase the amount of memory available by exiting from the program and then restarting it. 
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You can now control the size of dialogs 

In previous versions, the size of each dialog was fixed. In v7.0 you can change the size and 

proportions of a dialog by dragging the sides or corners. As you change the size, the fields will be 

rearranged to fit the changed space available. 

The program remembers the size that you set for each dialog 

If you change the size of a dialog while working in it, it will keep the changed size for the next time 

you open it. 

The program remembers the size separately for each dialog, so you can set your favourite working size 

for the Leak Scenario dialog and for the Weather dialog, for example, and it will open each dialog 

with the appropriate size for that type of dialog. 

The program can also remember the size that you set for arrays within a 

dialog 

Some dialogs include arrays (or tables) as shown in the 

illustration. Each array has a “resize” control in the form of a 

triangle of dots at the bottom right of the table, and you can 

drag this triangle to change the size of the table to make it 

easier to work with, as shown in the illustration. 

For each dialog, the program will remember the size that 

you set for each array in the dialog if the Save table width and height option is checked in the 

Application Preferences dialog. To open the Application Preferences dialog, click on the Preferences 
button at the bottom right of the File tab in the Ribbon Bar. 

However, if you changed the width of the columns for a particular array, the program will not 

remember this change and the next time you open the dialog you will find that the columns have 

returned to the standard width. 

For further details in the Help: In the Index tab, enter “Input Dialog” for details of the features of 

dialogs and techniques for working with them. 

Improved Search functionality 

The Home tab of the Ribbon bar includes a Search section 

which allows you to search the Study Tree and the Output 

View for a particular piece of text in the names of nodes or in messages. 

Enter the search term in the Search value field and then click on the Search button. All of the nodes or 

messages that include the search term will be listed in the Search View, which is a separate pane that 

appears by default in the same group as the Output View: 

 

If you double-click on the entry for a search result in the Search View, the program will select that 

item in the appropriate View, and if the item is a node in a tree View, it will expand the tree as 

necessary to make the item visible. If you press the [Ctrl] key while double-clicking on the entry for a 

node in a tree View, the program will also open the input dialog for that node. 

For further details in the Help: In the Index tab, enter “Home tab”. 
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Improved display in tree of status of data and results 

The Study Tree lets you see at a glance the state of the input data and of the results, and now 

also allows you to see details of any problems. 

Icons at the top left of a node show the status of the input data 

In the illustration, an error status-icon is to 

the left of a standalone Jet Fire Scenario 

node, and this means that it is showing the 

status of the input data. The data-status is displayed on nodes in all Views of the Study Tree. If you 

hover the mouse over the status-icon, a tooltip text will appear as shown, giving details of the status. 

The types of data-status that are displayed on the tree are as follows: 

 

Error A mandatory input field is unset, or a field has a value that is 

outside the range of permitted values. You will not be able to run 

calculations for the node while it is in this state. 

 

Warning A field has a value that is in the warning range of permitted 

values. You will be able to run calculations for the node while it 

is in this state. 

 Complete and within range 

but not all defaulted 

If all of the values are within range but some of the field are not 

taking default values, there will be no status icon displayed to the 

left of the node. 

 

All defaulted All of the fields are taking default values. This allows you to see 

at a glance whether a node such as a Material or a group of 

Parameters has been edited. 

Icons at the top right of a node show the status of results 

In the illustration, the status-icon is to the right of the Scenario 

node, and this means that it is showing the status of the results 
for the node. The results-status is only shown for nodes in the 

Models tab of the Study Tree. If you hover the mouse over the status-icon, a tooltip text will appear as 

shown, giving details of the status. 

The types of results-status that are displayed on the tree are as follows: 

 

Error The calculations have been run and gave at least one error. A complete 
set of results will probably not be present. 

 

Warning The calculations have been run and gave at least one warning. A 

complete set of results will normally be present. 

The warning icons will only be displayed on the tree if Show Warning 

Indicators On Tree is checked in the Application Preferences dialog. 

To open this dialog, click on the Preferences button at the bottom left of 

the File tab in the Ribbon Bar. 

 Not yet run with current 

input data 

If the calculations have not yet been run with the current set of input 

data, there will be no status icon displayed to the right of the node, and 

no results will be present. 

 

Run successfully The calculations ran without any errors or warnings, and a complete set 

of results is present. 

If you change the input data for a Scenario after running the calculations, the results for the Scenario 

will be deleted, and the results-status icon will disappear. 
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The icon shows the most severe status for the node 

If a node has both errors and warnings present, the status will be shown as error, since this is the most 

severe status. The tables above show the types of status in descending order of severity. 

For further details in the Help: In the Index tab, enter “Study Tree” for details of the features of 

the Study Tree and of techniques for working with it. 

Graph Wizard tool for adding user-defined graphs for results 

Not applicable to Phast Lite 

The Graph Wizard 

is an option in the 

Tools tab of the 

Ribbon Bar that 

allows you to define 

a new type of Graph (or “Graph Template”), which will be included in the Graphs View when you 

view the Graphs for a Scenario that has results available of the type that are covered by the new Graph 

(e.g. dispersion results, or jet fire results, or explosion results). 

To define a new Graph Template, take the following steps: 

1. Run the calculations for a Scenario that has the type of results that you want to use in the new 

Template. 

2. Click on the Graph Wizard button in the Tools tab of the Ribbon Bar to open the Graph Wizard 

dialog. 

3. Work through the screens in the dialog to define the results fields to plot in the Graph, the text 

to use in the titles, the style for different aspects of the Graph, and the group or category of 

Graphs to which it belongs. 

4. Click on Finish in the final screen to create the Template. 

If you then view the Graphs for the Scenario, you will see the Graph in a tab of its own, within the tab 

for the group that you selected. 

The Manage Templates option in the Ribbon Bar will open a dialog that lists all of the user-defined 

templates that are present on the machine, and allows you to delete a selected template. 

For further details in the Help: In the Index tab, enter “Graph Wizard” for an overview of the 

Wizard and details of the different screens. 
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Smooth integration in interface between pseudo-component and 
multi-component materials modelling 

Not applicable to Phast Lite 

In previous versions, the form and details of input data for components and mixtures in the Materials 

tab were different depending on whether or not you had a license for the multi-component modelling 

of mixtures. If you did have a license, you had to use different Models in order to choose between 

pseudo-component and multi-component modelling of mixtures, with the Vessel/Pipe Source Model 

and User-Defined Source Model always using pseudo-component modelling, and the Multi-

Component Vessel Model always using multi-component modelling. 

Materials input data in the Materials tab 

In v7.0, the Materials tab uses the same data structure and the same input 

dialogs for components and mixtures, whether or not you have a multi-

component license. There is a single dialog for editing the property settings 

for a pure component, and a single dialog for defining a mixture. 

Both dialogs include fields for choosing a Property 

Method Template from a list, and this is how you choose 

the equation of state (and other types of method) to be used 

in the calculations for the component or mixture. 

Note: one of the templates available is called “PhastMC”, 

as shown in the illustration. This template has a selection of 

methods that is particularly suitable for the multi-component modelling of 

mixtures, but the template is also applicable to pseudo-component modelling. 

For further details in the Help: In the Index tab, enter “Material data” for an overview of working 

in the Materials tab of the Study Tree. 

Choosing between pseudo-component and multi-component modelling for 

particular Scenarios 

In v7.0, you do not have to use 

different Equipment items or 

Scenarios in order to choose 

between pseudo-component and 

multi-component modelling. For 

the Pressure Vessel and the 

Atmospheric Storage Tank 

Equipment items, there is a Multi 

or pseudo-component modelling 
field in the Materials tab that will 

be enabled as shown if you have a 

multi-component license. This 

field allows you to choose 
between pseudo-component (PC) 

modelling and two options for 

multi-component (MC) 

modelling. You can change back 

and forth between the types of 

modelling, without having to 

change anything else in the data 

for the Equipment item. 
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Note: If you choose one of the multi-component options, you will not be able to insert or run any time-

varying, User-defined or Spill Scenarios for the Equipment item. Any such Scenarios that are already 

present under the Equipment item will be shown as de-selected if you change to multi-component 

modelling, and the option to run them will be disabled. 

Note: the multi-component modelling for a storage Scenario is not able to model the changes involved 

in liquid rainout, pool formation and evaporation, and rainout will never occur when a multi-

component option is selected, even when the liquid in the cloud contains a high proportion of heavy 

components. 

For further details in the Help: Click on the Help button in the Material tab of the Pressure Vessel 

or Atmospheric Storage Tank dialog. This will open the topic that 

describes the fields in the tab section in detail, with links to other 

related topics. 

New Spill Scenario links user-defined liquid spill with dispersion 
and effects calculations 

Not applicable to Phast Lite 

A user-defined liquid spill is one in which the user defines the amount and temperature of material that 

spills onto the ground to form a pool, independent of any droplet and rainout calculations performed in 

dispersion calculations. In earlier versions, the modelling of pool spreading and vaporisation for a 

user-defined liquid spill was available only as a standalone Model, which performed the pool 

modelling but did not perform any calculations of dispersion or hazardous effects for the vaporised 

material or for the pool. 

In v7.0, a new type of storage Scenario called a Spill Scenario is 

available under the Atmospheric Storage Tank Equipment item. This 

Scenario allows you to specify a user-defined spill, and it will then 

model the pool behaviour, and then perform dispersion and effects 

calculations for the vaporised materials, and also pool fire 

calculations for the pool. 

Standalone Pool Vaporisation Models will be 

upgraded to Spill Scenarios 

If you open a v6.7 *.psu file that contains standalone Pool 

Vaporisation Models, these models will all be upgraded to Spill Scenarios. 

Scenarios for non-flammable materials will be shown as incomplete on upgrade 

If the material selected for the Model was not flammable, then the Spill Scenario will initially be 

shown as incomplete, with the tooltip for the error icon on the node saying that the concentration of 

interest is unset. In order to run the dispersion calculations, the Scenarios need a stopping criterion for 
dispersion in the form of either a minimum concentration or a maximum distance of interest. For a 

flammable material, the program will base the concentration of interest on the lower flammable limit, 

but for a toxic or inert material, you will have to supply a stopping criterion yourself before you can 

run the calculations. 

The maximum time of interest is not a user input for the Spill Scenario 

For the standalone Pool Vaporisation Model, the input fields include a maximum time of interest, 

which sets a limit to the time after the start of the spill for which the behaviour of the pool will be 

modelled. The maximum time is not a user input for the Spill Scenario, which always uses a maximum 

time of one hour. 



Phast v7.0 Release Notes 21 Other enhancements and bug fixes 

When you upgrade a v6.7 *.psu file that contains Pool Vaporisation Models with the maximum time 

of interest set to a value other than 3600 s, warning messages will be written to the Output View about 

the fact that the time is no longer an input and that results may change. 

The Spill Scenario can only be run with pseudo-component modelling of 

mixtures 

You can only run the calculations for a Spill Scenario if the Multi or pseudo-component modelling 

option for the Atmospheric Storage Tank is set to “PC modelling” (i.e. pseudo-component modelling). 

If this option is set to one of the “MC” (multi-component) options, any Spill Scenarios under the 

Equipment item will be disabled and will not be included when calculations are run, as the multi-

component calculations for a storage Scenario do not cover pool behaviour, and pool formation is 

never modelled when this type of modelling is selected. 

Ammonia spills on water will give different pool vaporisation results from 

previous versions 

For ammonia spills on water, the solution of the ammonia in the water is modelled. In 6.7 the 

standalone Pool Vaporisation Model uses correlations for the properties of water that are different 

from the DIPPR correlations that are used in calculations for a Source Model. 

A Spill Scenario in v7.0 uses the DIPPR correlations that are used in v6.7 for a Source Model, and this 

means that a Spill Scenario for an ammonia spill on water will give different pool vaporisation results 

that the equivalent standalone Pool Vaporisation Model in v6.7, because the properties of water are 

being calculated differently, in a way that is more consistent with the other property calculations. 

There are limitations in the handling of dispersion modelling for an 

instantaneous spill 

For a continuous spill, the program uses the pool vaporisation results directly in the dispersion 

calculations, and the dispersion results will show the behaviour of the series of representative 

continuous pool vaporisation segments. However, for an instantaneous spill the vapour produced from 

the pool is added in to the very small instantaneous cloud that is assumed to form before the liquid 

spills onto the ground, and the dispersion results will show the behaviour of an instantaneous cloud, 

and not of a continuous release from pool vaporisation. 

If you want to model the dispersion and hazardous effects from an instantaneous spill using the series 

of representative continuous pool vaporisation segments instead of the instantaneous cloud, you 

should take the following steps: 

1. Run the calculations for the Spill Scenario. 

2. Right-click on the Spill Scenario and select the Create source option for the Weather whose 

pool vaporisation results you want to use in the dispersion modelling.  

The program will create a User-defined source Scenario under the same Atmospheric Storage 

Tank as the Spill Scenario. 

3. Run the calculations for the User-defined source Scenario and view the results, which will 

show the dispersion behaviour of the series of continuous pool segments. 

For further details in the Help: In the Index tab, enter “Spill Scenario”. 
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Other differences and bug fixes 

Other new features for v7.0 

There will always be a workspace open in the program 

In previous versions, the program could have no Study Folder open, either on start-up, or if you used 

the Close option in the File menu. In this situation there would be no Study Tree present. 

In v7.0, the program starts up with a new blank workspace already opened, and if you use the Close 

option in the File tab of the Ribbon bar, the current workspace will be closed and a new blank 
workspace will be opened. This means that the Study Tree is always present (unless you have 

manually closed every View in the Tree). 

Selection of Scenarios and Weathers for running is done directly in the tree 

In previous versions, a dialog called the Batch Setup dialog was used to choose which Models and 

Weathers would be included in a Batch Run, or when the calculations were run for the Study Folder 

node at the top of the tree. 

In v7.0 there is no Batch Setup dialog and no Batch Run option, and the only 

way to run calculations is to select a node in the Models tab and select Run. 

This will run all Scenarios under that node, for all Weathers in the Weather 

Folder that is selected for the Study for that node, except for Scenarios and 

Weathers that have been excluded from calculations using the Exclude from 
calculations option in the right-click menu, as shown in the illustration. 

If a Scenario or Weather has been excluded, its name will appear greyed-out in 
the tree, as shown for the Weather 01_Category 1.5/F in the illustration. If a 

Scenario or Weather is excluded, the menu option will change to Include in calculations, and you can use 

this to stop excluding the node. 

Note: when you upgrade a v6.7 file, all Scenarios and Weathers will initially be selected for running. 

The Batch Setup selections from the v6.7 file are not included in the upgrade. 

The GIS coordinate system is now pre-set to the Rectangular Grid system 

In previous versions, the coordinate system for the GIS was initially unset in any new Study Folder, 

and the first time you opened the Map Window or inserted map image data, the Coordinate System 

Wizard dialog would open, prompting you to select the coordinate system to use. If you did not want 

to select a defined system (e.g. a national grid system), then you could click on the Default button to 
use the “Rectangular Grid” system. 

In v7.0 the coordinate system for a new workspace is preset to the “Rectangular Grid” system, and this 

means that the Coordinate System Wizard dialog does not appear when you perform your first 
operation with the GIS, as the system is never undefined. 

If you want to select a defined system for the workspace, you must click on the Co-ordinate 
System button in the Tools tab of the Ribbon bar, which will open the Storage Coordinate 

System dialog. You can also use the Default option under this button to return the system to 

“Rectangular Grid”. 

For further details in the Help: In the Index tab, enter “Coordinate Systems” to see details 

of selecting a system or an overview of map projections or of 

working with GIS Views. 
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Separate GIS Results window used to display effect zones on a map 

In previous versions, a Map tab within the Graphs Window was used to display footprint and effect 

contour results against the background of a map. 

In v7.0, a new type of window called a GIS Results View is used to display map-

based effect-zone results, and this is completely separate from the Graphs View. To 

view the results for a Scenario or set of Scenarios on the GIS, select a Scenario in the 

Models tab or a Weather in the Weathers tab, and then select the GIS option from the 

Results section of the Home tab in the Ribbon bar. 

A Select dialog will appear, asking you to select the Weathers or Scenarios whose results you want to 

view. When you click on OK, a GIS Results View for the selected Scenario or Weather will then open, 

displaying the default type of effect for the set of Scenarios covered by the View (e.g. the cloud 
footprint for a storage Scenario). 

The GIS Results View can display footprint or contour results for a range 

of types of effect. The Event field in the Consequence tab of the Ribbon 

bar gives an alphabetical list of the types of effect for which results are 

available for the set of Scenarios and Weathers covered by the GIS View, 

and you use this list to select the type of effect to display. The illustrations 

shows the list of effects for a Scenario with results for cloud dispersion 

and for flammable and toxic effects, but the details of the list will depend on the details of the 

Scenarios. 

For further details in the Help: In the Index tab, enter “GIS Results View” for an overview of 

working with the GIS Results View. 

The choice of initial averaging time for Dispersion Graphs is more consistent 

Any reported value for cloud concentration must have an averaging time associated with it, i.e. it is a 

value calculated using a specific averaging time. A given storage Scenario may have dispersion results 

available for more than one averaging time, depending on the settings in the Dispersion tab section, 

but when the Graphs View first opens, one averaging time will be set as the averaging time for the 

initial view. The selection of this time has been changed for v7.0, to make it more consistent. 

In previous versions the toxic averaging time would be used if the material was toxic-only or both 

flammable and toxic, and the flammable averaging time would be used if the material was flammable-

only. A user-defined averaging time would never be used for the initial view, even if this time had 

been set as the time to use for calculating the concentration of interest. 

In v7.0 the averaging time for the initial view is set as follows: 

• to the Averaging time for concentration of interest set in the Dispersion tab for the 

Scenario. 

• if a Concentration of interest has not been specified for the Scenario: 

o to the Flammable time if the material is flammable 

o to the ERPG time if the ERPG box is checked in the Dispersion tab 

o to the Toxic time if the material is toxic and the ERPG box is not checked 

This change means that the results in Dispersion Graphs may appear different between v7.0 and v6.7 

when the Graphs first open, because they are using a different averaging time. The Content Panel at 

the left of the graph shows which type of averaging time is being used and gives the value (e.g. 600 s). 

To change the selection of averaging time for Dispersion Graphs in v7.0, click on the Edit 
Settings option in the Consequence tab of the Ribbon Bar. The Edit Settings dialog will open, 

and the Averaging Time Index field in the Graphs tab of the dialog will list the different 

averaging times for which dispersion results are available for the current Graphs View. 
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New file format for workspace files 

The default file format in v7.0 is a *.psux file, which is a compressed xml format. 

You cannot save to *.psu files, which means that you cannot open a file created in v7.0 in any earlier 

version. 

The Save option will always save both input data and results 

In previous versions, the File menu and the Save As dialog gave a choice between saving input data 

only, or saving both input data and results. 

In v7.0, the Save option will always save all data that are currently present in the workspace, which 

will include any results present, as well as the input data. 

If you want to save input data only to reduce the size of the *.psux file, 

then you can delete all results before saving the file by right-clicking on the 

workspace node at the top of the Study Tree and selecting Clear all results 
and dependencies from the bottom of the right-click menu, as shown. 

For further details in the Help: In the Index tab, enter “Right-click 

menus” to view the summary of the 

limitations. 

 

A standalone Jet Fire Scenario can be generated from a storage Scenario 

Not applicable to Phast Lite 

You can create a standalone Jet Fire Scenario from all types of storage Scenario except for 

Catastrophic rupture Scenarios and Spill Scenarios. 

If the storage Scenario involves a continuous release of a flammable material and if it has up-to-date 

results present, then the option Create a standalone jet fire will be present in the right-click menu. If you 

select the option, the program will create a Standalones Equipment item with a standalone Jet Fire 

Scenario under the same Study as the selected node, using the material, location and direction data 

from the input data for the Equipment and Scenario, and the discharge results for the last Weather. If 

the discharge data for the Weather involve more than one release segment (i.e. if there are time-

varying discharge data), the program will use the data for the first release segment. 

You can use the standalone Jet Fire Scenario to investigate the radiation results in more detail than is 

available with the storage Scenarios. 

Default values are supplied for Baker-Strehlow-Tang explosion modelling 

Not applicable to Phast Lite 

In previous versions, the Mach number method for the Baker-Strehlow-Tang explosion modelling was 

initially set to “Calculate the Mach number” rather than using a user-supplied value for the Mach 

number, and no values were set for the other inputs for the modelling. 

In v7.0, the method is now initially set to “Mach number supplied”, the User specified flame Mach 

number set to 1.2, and the Correction for the ground effect set to 1. For a storage Scenario, the 

Confined volume is initially set to 1 m
3
, giving a complete set of input data for the explosion 

modelling. For a standalone Baker-Strehlow-Tang explosion Scenario, however, there are some input 

fields that are not supplied with default values, and you will have to complete these values before you 

can run the explosion calculations. 

The default values for the modelling are set inside the program, not in the Parameters, which means 

that you cannot change the default values. 
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Most workspace-level options are now set in the workspace dialog 

Workspace-level options are settings that apply to the entire workspace, and that can be made specific 

to a particular workspace and saved with the workspace file. 

In previous versions, most workspace-level 

options were set in the various Preferences 

dialogs. In v7.0, most workspace-level options 

are now set in the workspace dialog (i.e. the 

dialog for the node at the top of the Study Tree). 

This is different from previous versions of Phast, 

where the node at the top of the tree did not have 

any input data. 

Workspace-level options that affect the 

appearance of GIS Views were set in the Map 

Preferences in previous versions but are now set 
using the options in the Display section of the 

General tab of the Ribbon bar. This tab appears in 

the Ribbon bar when a GIS View has focus (i.e. 

was the last view that you clicked in). 

Note: Some of the workspace-level options that 

were in the Preferences in previous versions have 

not been included in v7.0 because they are no 

longer relevant. Details are given in the next section. 

For further details in the Help: In the Index tab, enter “Workspace dialog” for an overview of the 

dialog or “General tab” for details of the GIS options. Click on the 

Help button in the workspace dialog for details of the fields in the 

current tab section. 

Program-level options are now set in a new Preferences dialog 

Program-level options are settings that apply to the program as a whole, and that are not specific to a 

particular workspace. 

In previous versions, program-level options were set in the Installation and General Preferences 

dialogs along with workspace-level options. In v7.0, the program-level options have been separated 

from the workspace-level options and placed in a new Preferences dialog that you open by clicking on 

the Preferences… option in the File tab in the Ribbon bar. 

Most of the options in the dialog are new 

with v7.0, and affect the behaviour of new 

aspects of new user interface, such as 

whether or not to save changes that you 

made to the arrangement of Views. 

Many of the program-level options that 

were in the Preferences in previous 

versions have not been included in v7.0 

because they are no longer relevant. 

Details are given in the next section. 

For further details in the Help: 

Click on the Help button in the Preferences 

dialog for details of the fields. 
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The online Help applies to both Phast and Phast Lite 

In previous versions, the Help was different for the two product modes, but in v7.0, the same Help 

content is used for both. 

The Help describes the full set of 

features for Phast, and icons are 

used to identify the parts of the 

Help that do not apply to Phast 

Lite, as shown in the illustration of 

the topic on the Admin programs. 

One type of icon appears to 

the right of any part of the 

Help that does not apply at all to 

Phast Lite (e.g. the details of 

Parameters). 

Another type of icon appears 

to the right of any part of the 

Help that applies only partly to 

Phast Lite. 

If one of these icons has a border around it, then you can click on the icon view a summary of the 

limitations for Phast Lite. 

This approach is intended to avoid confusing Phast Lite users without distracting Phast users. 

For further details in the Help: In the Index tab, enter “Phast Lite” to view the summary of the 

limitations. 

The Excel Input and Output now includes Parameters and allows you to skip 

the import of Mixture compositions 

Not applicable to Phast Lite 

The program is supplied with a template spreadsheet (installed to the Excel folder for the program 

files), and you can use spreadsheets based on this template to collect input data for Studies, 

Equipment, Scenarios, Weathers, Parameters and Mixture compositions. The Excel Input and Excel 
Output options in the Data tab of the Ribbon bar allow you to import data from one of these Excel files, 

and to export input data from the program to an Excel file. 

In previous versions the template spreadsheet did not cover Parameter data, but this is now included. 

There is now an option in the Mixtures tab of the template spreadsheet to choose between skipping 

the import of a Mixture if the workspace already contains a Mixture with the same name, and 

proceeding with the import in order to replace the Mixture in the workspace with a new Mixture that 

has the composition data defined in the spreadsheet. The only aspect of materials data that is included 

in Excel Input and Excel Output is the Mixture composition, and if you have defined non-default property 

values for a Mixture in your workspace and you do not want these values to be overwritten when you 

import from a spreadsheet that contains a Mixture with the same name, you should make sure that the 

option in the Mixtures tab of the spreadsheet is set to Skip on import and not to Replace on import. 
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Separate programs for editing System Materials and System Parameters 

When you install the program, separate Admin programs are also installed, as 

shown. These programs are provided for editing System Materials and System 

Parameters, and replace the Phast Admin program supplied with previous versions. 

Note: for Phast Lite, only the Admin Materials program will be installed. Values for 
Parameters cannot be changed in Phast Lite. 

Each of these programs has a Study Tree with a single tab, which displays only the nodes for that type 

of System data. This is different from the Phast Admin program, where the Study Tree includes all of 

the tabs from the main Phast program, in addition to System tabs. The new Admin programs are more 

straightforward, and easier to use. 

Note: there is no Admin option in v7.0 for updating the definition of a new workspace (i.e. the 

workspace to be used as the starting point when you select the New option from the File tab of the 

Ribbon bar). This is discussed further in the section below on functionality that has not been included 

in v7.0, which gives details of the manual steps to take if you want to change the definition. 

Each Admin program includes an Upgrade Phast 6.7 option that allows you to upgrade values from a 

v6.7 system file and use these upgraded values as the system values for the current program. When 

you upgrade a parameters file, a dialog appears listing differences between the values in the v6.7 file 

and the current v7.0 system parameters, and asking if you want to overwrite the v7.0 values with the 

upgraded v6.7 values. In this dialog, the value for some parameters will be given as “Missing 

attribute” in either the v6.7 file or the v7.0 file: 

Parameters with the v6.7 value given a “Missing attribute” 

These parameters are all parameters that are new in v7.0, e.g. for the new multi-component pool 

vaporisation modelling. 

Parameters with the v7.0 value given a “Missing attribute” 

These are parameter that are not included in the set of parameters in v7.0. Some of these parameters 

deal with functionality that has not yet been included in v7.0 (Warehouse Fire Parameters), some are 

not relevant to Phast v7.0 because they deal with modelling for risk calculations (some Explosion 

Parameters), some have been moved to a different Parameters node (some Toxics Parameters, which 

are now under the new Building Parameters node), some are used only in Version 1 of the dispersion 

modelling, which is not supported in v7.0 (some droplet parameters), and some were not used in either 

v6.7 and v7.0 and have now been removed (ground drag and solid CO2 parameters). 

For further details in the Help: In the Index tab, enter “Administration functions” for an overview 

of the Admin programs. 
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Functionality that has not been included in v7.0 

Some functionality that was present in earlier versions has not been included in v7.0. 

The modelling of some types of event is not yet included 

Not applicable to Phast Lite 

Some types of Model or modelling option that are present in v6.7 have not been included in this first 

release of Phast v7.0, as follows: 

• Long pipeline discharge modelling 

• Building wake dispersion modelling 

• Tank-roof collapse modelling 

• Vent from vapour space modelling for atmospheric storage conditions 

• The Warehouse Fire Model 

This modelling will be included in a later release. 

The Audit Report is not yet included 

Earlier versions include an Audit Report that appears in every Report window, giving the details of the 

background data used in the calculations, i.e. for Parameters and Materials, and of the version numbers 

of the various software modules that make up the program. 

The Audit Report will be included in a later release. 

The Autosave feature is not yet included 

Earlier versions have an Autosave function, controlled by options in the Installation Preferences 

dialog. If this function is turned on, then at regular intervals the program will automatically save the 

current state of the Study Folder to an Autosave folder. You can use this copy of the Study Folder to 

recover your work if the event that the program or your computer shuts down unexpectedly before you 

are able to save the Study Folder in the normal way. 

The Autosave features will be included in a later release. 

Control over the display of the Scenario path in Graphs is not yet included 

Earlier versions have an option in the Graph Preferences dialog that allows you to control how many 

levels of a Model’s path are given in the Legend for Graphs. For example, you can state that only the 

Model’s name should be given in the Legend, or you can state that the level above should be included 

(e.g. the Folder or Study above the Model), or that all levels should be included. If the Graph covers 

Models that have the same name (e.g. “Catastrophic rupture”), then you will need to display enough 

levels of the path to be able to identify the different Models and their results in the Legend. 

Control over the display of the Scenario’s path will be included in a later release. 

The option to freeze and reset defaults for a node is no longer being supported 

In previous versions, the right-click menu for a node in the Study Tree included the options to freeze 

defaults for the node, and also to reset to defaults if identical. You could use the first option to break 

the link to the defaults system so that values for the node would not be changed if the default value 

was changed, and you could use the second option to restore the link to the link to the defaults system, 

resetting fields to be defaulted if the value was the same as the current default value. 
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Some modelling options are no longer being supported 

Some options are no longer relevant and are not being included in Phast: 

• Version 1 of the Unified Dispersion Modelling (UDM) 

The Version 1 UDM model was the model that was available in v6.54 and earlier versions.  

The Version 2 model is a more robust enhanced model, introduced in v6.6. In v6.6 and v6.7 

there was a field in the Dispersion Parameters that allowed the user to choose between the two 

versions for comparison and compatibility, with the default set to Version 1 in v6.6, and 

changed to Version 2 in v6.7. It has now been firmly established that Version 1 offers no 

advantage over Version 2 in any aspect of the modelling and it has not been included in v7.0, 

so there is no option in the Parameters to choose between the two versions. 

• Caselists 

Not applicable to Phast Lite 

In earlier versions, Caselists provided a way of sharing input data between release-definitions, 

e.g. for leaks with different hole sizes from the same vessel. The structure of Equipment items 

and Scenarios in v7.0 provides a better way of sharing input data, as it is more flexible and 

gives greater visibility of the design, and the Caselist will no longer be included in Phast. 

If you open a v6.7 *.psu file that contains a Caselist, the Caselist will not be upgraded, and 

warning messages will be written to the Output View telling you that Caselists are not 

supported. If you want to retain the data from the Caselist, then before you perform the 

upgrade you should open the *.psu file in v6.7, right-click on the Caselist and select the option 

to Convert caselist to models, and then save the file. 

Some data input options are no longer being supported 

Some options for setting up input data are no longer included in Phast: 

• Discharge calculation option in input dialog for standalone Jet Fire 

In earlier versions, the input dialog for a standalone Jet Fire includes the option to specify 

storage conditions and a hole diameter, and to perform discharge calculations to obtain values 

for the discharge conditions (i.e. mass flowrate, expanded temperature, expanded diameter and 

liquid fraction), which are required for the calculations of the shape and emissive power of the 

flame. If the Calculate Discharge option is checked in the dialog, the discharge condition 

fields are disabled, and the values are calculated during the calculations for the Jet Fire Model. 

The option to calculate the discharge conditions is not present in the input dialog for a 

standalone Jet Fire Scenario in v7.0. However, you can use the discharge results for a suitable 

storage Scenario to set the values for the discharge condition fields for a standalone Jet Fire 

Scenario if you run the calculations for the storage Scenario and then right-click on the 

Scenario and select Create a standalone jet fire. The program will use the discharge results for 

the last Weather, and if the discharge data for the Weather involve more than one release 
segment, the program will use the data for the first release segment. 
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• Vessel Wizard 

Earlier versions included a Vessel Wizard that took the user through the stages in completing 

the most important data for a Vessel/Pipe Source Model. With the new data structure, this is 

no longer relevant. 

• Export and Import options for parts of a Study Folder 

Not applicable to Phast Lite 

In earlier versions the right-click menu for a node in the Study Tree included Import and Export 
options that allowed you to export the data for that part of the Study Folder to a *.psu “Study 

Folder fragment” file, and then to import the data from such a fragment file into another Study 

Folder. With the Grid View allowing easy data-entry, this is no longer considered necessary. 

Some options from the Preferences are no longer being supported 

Some options that were included in the Preferences dialogs in earlier versions are not being included 

in Phast: 

• Startup options from Installation Preferences 

These give options for opening a file on program startup, which are no longer relevant or 

necessary. 

• Output options from Installation Preferences 

These give options for the default state of Reports Views, which are no longer relevant. 

• Reports options from General Preferences 

These allow you to select which Reports will be included in Reports Views (i.e. to exclude 

Reports), which is no longer considered necessary. 

• Some Results options from General Preferences 

The option to select particular input or output fields for logging to the Log Window during 

calculations has been superceded by the new options in the workspace dialog to Log inputs to 

models on the message window and to Log outputs from models on the message window, 

which will include all input and output fields. 

The options to save results on file as they are calculated and not to save detailed pool 

vaporisation results are no longer considered necessary. 

• Some Miscellaneous options from General Preferences 

The options not to run linked models after dispersions and to prompt before deleting or 

invalidating results after an edit operation are no longer considered necessary. 

• Some Graphs options from Graphs Preferences 

The warning limits for the number of grid cells and the option to use data culling are no longer 

relevant with the new Graphs interface. 

• The Contours options from Graphs Preferences 

The options to set the default colours and line-widths for contours and effect zones are no 

longer considered necessary with the new Graphs interface. 
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The Admin function for defining the new workspace is no longer supported 

In previous versions, the Phast Admin program for editing the System Materials and Parameters 

includes the option to save the current Study Folder as the “New Study Folder”, i.e. to be used as the 

starting point whenever you select the New option from the File menu or Toolbar. 

There is no equivalent of this option in Phast or in the Admin programs. If you want to change the 

definition of a new workspace (e.g. changing the definition of the default set of Weathers), you must 

take the following steps: 

1. Set up the data that you want to appear in each new workspace. 

2. Select Save As from the File tab. 

3. In the File Save dialog, browse to C:\ProgramData\DNVS\PHAST_7_0_0\Admin. 

4. For the File name field in the File Save dialog, enter “PhastConsequence.new” (for Phast) or 

“PhastLite.new” (for Phast Lite). 

5. Click on Save to overwrite the existing file. 

The next time you create a new workspace - by selecting either New or Close from the File tab – the 

version that you saved to the *.new file will be used. 

For further details in the Help: In the Index tab, enter “New workspace” for details of updating the 

definition. 
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Bug fixes for v7.0 

There are several bug fixes in the modelling and the user-interface for v7.0.  

For a complete list of bugs fixed since v6.7, see the Technical Support area of the DNV Software 

website: http://www.dnvsoftware.com. In order to access the support information, you must enter a 

valid user name and password, which you can obtain from your local DNV Software office. 

The D number given for each item is a unique reference number. If you require more information on a 

particular item, please quote the D number when you contact the Support Desk. 

 

D-01827 Discharge calculations for short pipe Scenarios may give higher release rates than 

the equivalent cases in v6.7. 

Description There is a bug in v6.7 in the discharge calculations for line rupture, disc rupture and 

relief valve scenarios which meant that the convergence in the calculations was 

unreliable and sometimes failed. This has been fixed, and the calculations are now 

quicker, give more accurate results (which are typically higher than in v6.7), and are 

less likely to give errors or warnings about the results failing to converge. 

 

D-02256 In input data for a pure material components, triple point data and laminar burning 

velocity are now correctly shown as required input data 

Description There is a bug in v6.7 in the handling of input data for a pure material component, 

and the input fields Triple Point Pressure, Triple Point Temperature and Laminar 

Burning Velocity are never shown as being mandatory. This means that you can 

leave these fields blank, and the component will be shown as complete and can be 

selected for use in Models. However, if the triple point data is unset, the Models will 

give errors in calculations, and if the laminar burning velocity is unset, the Models 

will give errors in calculations for in-building releases and for multi-energy 

explosions, if these options are selected for the Model. 

This has been fixed in v7.0 and these fields are now always shown as mandatory. 

You must supply values for the fields in order to be able to select the Component for 

an Equipment item. 

 

D-02439 Discharge calculations for a mixture may give a different droplet diameter compared 

with v6.7 

Description For a Scenario involving a mixture, the droplet diameter given in the Discharge 

Report may be different from the diameter for the equivalent Model in v6.7. 

There is a bug in v6.7 which means that the droplet calculations for a mixture are 
based on the storage state (e.g. two-phase storage), rather than on the discharge state 

(e.g. vapour). This inconsistent behaviour has been fixed in v7.0, and the calculated 

droplet diameter may change as a result. 

 

http://www.dnvsoftware.com/
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D-02446 Radiation dose for jet fire effects for short-duration releases may be different 

compared with v6.7 

Description There is a bug in v6.7 which means that the exposure duration used in calculating the 

radiation dose for a short-duration jet fire is the maximum exposure duration set in 

the Parameters, rather than the duration of the event. The default value for the 

maximum exposure duration is 20 s. 

This has been fixed in v7.0, so the dose value will be different from v6.7 for releases 

with a duration less than the maximum exposure duration. 

 

D-02587 Radiation dose for standalone Fireball may be different compared with v6.7 

Not applicable to Phast Lite 

Description There is a bug in v6.7 which means that the exposure duration used in calculating the 

radiation dose is the maximum exposure duration set in the Parameters, rather than 

the exposure duration set for the standalone Fireball Model. The default value for the 

maximum exposure duration is 20 s. 

This has been fixed in v7.0, so the dose value will be different from v6.7 for 

standalone Fireballs with an exposure duration less than the maximum exposure 

duration. 

 

D-02458 Discharge calculations from cryogenic storage conditions may give slightly different 

results compared with v6.7 

Description There is a bug in v6.7 which affects the material property calculations for cryogenic 

storage (e.g. of LNG or hydrogen), and means that calculations sometimes fail with 

the message “ERR 1: Run-time error 3 occurred”. 

This has been fixed in v7.0. Cases that fail in v6.7 should run successfully in v7.0, 

and cases that run in v6.7 and can be compared with v7.0 should show differences of 

no more than 0.1%. 

 

D-02459 Location and time for cloud touch-down given in Commentary Report are different 

compared with v6.7 

Description There is a bug in v6.7 which means that the lines in the Commentary Report which 

state the location and time for events in the touch-down process give the location and 

time for the dispersion step after the event takes place, not for the step itself. 

This has been fixed in v7.0, and the Commentary Report will give values for location 

and time that are earlier than given in v6.7 for the equivalent case. 
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D-02632 Late explosion results may be produced for cases which gave none in v6.7 

Description There is a bug in v6.7 which affects cases in which the dispersion calculations stop 

because the cloud has reached the maximum distance or height set in the Dispersion 

Parameters while the centreline of the cloud is still above the concentration of 

interest. In this situation the program does not identify the flammable region of the 

cloud correctly, and will not produce any results for late explosion. 

This has been fixed in v7.0, and late explosion results will be produced in this 

situation. 

 

D-02669 User-defined in-building leak Scenarios may give different dispersion results 

compared with v6.7 

Not applicable to Phast Lite 

Description There is a bug in v6.7 which affects the calculation of initial conditions for 

dispersion, for User-Defined Source Models with the Scenario type set to “Leak” and 

with “In-Building Release” selected. 

This has been fixed in v7.0, and the equivalent User-defined release Scenarios will 

give different results in the Dispersion Report, especially in the values for 

temperature. 

 

D-02993 Short pipe Scenarios may give different results compared with v6.7 if the Velocity 

capping method is set to Sonic velocity in the Discharge Parameters 

Not applicable to Phast Lite 

Description There is a bug in v6.7 which affects the calculation of discharge velocity for line 

rupture, relief valve and disc rupture cases if the Velocity capping method in the 

Discharge Parameters is set to “Sonic velocity”. For such cases, the representative 

discharge velocity will be capped to the value set in the Maximum release velocity 

field in the Discharge Parameters, and not to the sonic velocity, i.e. the program 

behaves as if the Velocity capping method were set to the default value of “Fixed 

velocity”. 

This has been fixed in v7.0 and such cases will be capped to the sonic velocity. This 
change in the discharge results will give changes in the dispersion and the effect 

results. 

 

D-03018 Short pipe Scenarios may give different results compared with v6.7, for cases which 

failed to converge in the discharge calculations in v6.7 

Description In v6.7, the short pipe discharge calculations sometimes fail to converge on a 

solution. In this situation they should give warning messages, but sometimes they do 

not, so there is no indication in v6.7 that the results of the discharge calculations are 

not correct. 

The handling of convergence has been improved in v7.0 and cases that failed to 

converge will now give correct results. 
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Alerts and workarounds 

There are some known bugs that have not been fixed in v7.0, and some aspects of the program that 

may give behaviour that you do not expect, e.g. because of minor enhancements or minor changes in 

the modelling that may produce slight differences in the results. 

For the most up-to-date list of known bugs and other issues, see the Technical Support area of the 

DNV Software website: http://www.dnvsoftware.com. In order to access the support information, you 

must enter a valid user name and password, which you can obtain from your local DNV Software 

office. 

The D number or SI number given for each item is a unique reference number. If you require more 

information on a particular item, please quote the number when you contact the Support Desk. 

 

D-01155 Alt key rather than Ctrl key is now used for moving nodes up and down the tree 

Description You can use the keyboard to move a given node in the Study Tree to a different 

position under the parent node by using [Alt]+[Up] and [Alt]+[Down]. This is a change 

from previous versions, when the key combinations used were [Ctrl]+[Up] and 

[Ctrl]+[Down]. 

You can also move nodes using the Move Up and Move Down  options in the 

toolbar along the top of the Study Tree pane and in the right-click menu. 

 

D-01265 Order of Equipment items created on upgrade might not be the same as the order of 

Models in the v6.7 file. 

Description When upgrading a v6.7 file, the program converts each Models into an Equipment 
item with a Scenario underneath it. For some files, the order of the Equipment items 

might not be the same as the order of the Models in the v6.7 file, i.e. they might 

appear in a different order in the Study Tree. 

 

D-01373 Differences in pool vaporisation and dispersion results compared with v6.7 

Description For some storage releases, differences may be observed between v6.7 and v7.0 in 

the representative pool vaporisation segments, with corresponding differences in 

dispersion results. 

Some changes were made in the modelling of rainout within the dispersion 

calculations in the course of introducing the Spill Scenario. These changes produced 

only very small differences in the detailed pool vaporisation results (e.g. differences 

of less than 0.1%), but such small differences can sometimes cause the 

representative pool vaporisation segments to be defined very differently, and this 

can give noticeable differences in the dispersion results. 

These differences are less likely to appear if the tolerance for the dispersion 

calculations is set to a low value, e.g. to 1e-4 instead of to the default of 1e-3. 

 

http://www.dnvsoftware.com/
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D-01470 For standalone Jet Fires at an angle to the wind, points and transects for radiation 

are defined in relation to the release direction rather than the flame direction 

Description For a standalone Jet Fire using the cone correlation, you can define the release at an 

angle to the wind (i.e. give a non-zero crosswind angle). The wind will then tilt the 

flame, so that the flame is at an angle to the release direction. 

In the input data for a standalone Jet Fire, you can define a point and a line (or 

transect) for which you want radiation results calculated. In previous versions, the 

location that you gave for a point and the angle that you gave for a line were taken 

as being in relation to the flame direction for a crosswind release (even though the 

labels in the input dialog stated that the location and angle were given in relation to 

the wind direction). In v7.0, the point and the angle are now taken as being in 

relation to the release direction, and the labels in the input dialogs have been 

changed to make this clear. 

This change means that standalone Jet Fires with a non-zero crosswind angle will 

give different results for radiation at a point and radiation versus distance compared 

with v6.7, because the locations defined for the points and lines are interpreted 

differently. 

 

D-01474 Option to reset rainout position to inside the bund no longer available 

Description In earlier versions, the Dispersion Parameters include an option to reset the rainout 

position so that rainout always takes place inside the bund, rather than in the 

location predicted by the dispersion modelling. This option is applicable to Version 

1 of the Unified Dispersion Modelling and not to Version 2, and as Version 2 is the 

only form of dispersion modelling available in v7.0, the option to reset the rainout 

position is also no longer available. 

 

D-02144 Equipment item may be shown as incomplete because time-varying inputs are out of 

range, even if all time-varying Scenarios underneath it have been deleted 

Not applicable to Phast Lite 

Description If a time-varying Scenario is present under a Pressure vessel or Atmospheric storage 

tank Equipment item, additional input data will become enabled for the Equipment 

item (e.g. the shape and dimensions of the vessel or tank), and additional checks 

will be performed on the compatibility of the input data. If the dimensions that you 

have given for the vessel or tank in the Time-varying release tab section are too 

small to contain the inventory that is specified in the Material tab section, the 

inventory field will be shown as out of range, and you will not be able to run the 

calculations for any Scenario under the Equipment item. 

If you delete all of the time-varying Scenarios from underneath an Equipment item 

that is out of range for this reason, it should be shown as within range, as the 

additional checks are no longer relevant. However, the program does not 

automatically recalculate the data requirements in this situation and the Equipment 
item will still be shown as out of range. To reset the status so that you can run 

Scenarios under the item, edit the item and change the setting for Specify volume 

inventory? This will cause the program to recalculate the status, and you can then 

change the setting back to the original setting and OK the dialog. 
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D-02222 Differences in Equivalent Toxic value at 0.1 m between Spill Scenario in v7.0 and 

corresponding User-Defined Source in v6.7 

Description After running a standalone Pool Vaporisation Model in v6.7, you can generate a 

User-Defined Source from it, using the pool vaporisation segments for the selected 

Weather as the input to the dispersion calculations. This allows you to compare the 

dispersion and effects results for that Weather with the results for the corresponding 
Spill Scenario in v7.0. 

For some Spill Scenarios, you may find that the Toxic Equivalent Graph gives a 

concentration level at 0 m downwind (i.e. at the release location) that is higher than 

the concentration calculated in v6.7. This difference occurs because the modelling 

for the Spill Scenario assumes that a cloud forms before the liquid spills onto the 

ground, and even though this cloud may be very small, it produces concentrations at 

the release location that are higher than in v6.7, where the combination of the 

standalone Pool Vaporisation Model and the User-Defined Source Model assumes 

that the concentration is produced only by the vaporising pool. 

 

D-02223 When upgrading a standalone Jet Fire Model from v6.7, the program will always 
take values from the discharge conditions fields, which might not have been the 

values used in v6.7 

Description In earlier versions, the input dialog for a standalone Jet Fire includes the option to 
specify storage conditions and a hole diameter, and to perform discharge calculations 

to obtain values for the discharge conditions (i.e. the mass flowrate, expanded 

temperature, expanded diameter and liquid fraction), which are required for the 

calculations of the shape and emissive power of the flame. If the Calculate 

Discharge option is checked in the dialog, the discharge condition fields are disabled, 

and the values are calculated during the calculations for the Jet Fire Model. 

The option to perform discharge calculations as part of the standalone Jet Fire 

Scenario is not included in v7.0. When the program upgrades a standalone Jet Fire 

from v6.7, it always takes the values from the discharge conditions fields, and ignores 

any inputs that are set for performing discharge calculations. 

In v6.7, it is possible to have values present in the discharge condition fields that are 

different from the values that will be calculated when the Model is run, e.g. if you 

had entered values manually at an earlier stage, before deciding to use the option to 

calculate the discharge results. If you upgrade a file that contains such a Model and 

then compare the results between v6.7 and v7.0, you will see differences because they 

are not using the same values for the discharge conditions. 

To avoid these discrepancies, you should edit the Jet Fire Model in v6.7 before 

performing the upgrade. In the Discharge tab section, click on the Calculate now 

button and then click on Yes in the dialog that appears showing the calculated 

discharge conditions. The program will set the discharge conditions fields to these 

calculated values, and will uncheck the Calculate Discharge option so that the 

program does not perform the discharge calculations when the Model is run, and will 

instead use the values set in the discharge conditions fields, as in v7.0. 
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D-02299 For Graphs that show results at a given downwind distance, the distance is now set to 

1 m for many Scenarios. 

Description Several Graphs show the results at a given downwind distance, including the 

Concentration vs Time Dispersion Graph, the Cross-Section Dispersion Graph, the 

Late Explosion at Distance Graph or the Accumulated Toxic Graph. 

If the Graph View covers any Scenarios that involve the release of a flammable 

material and that give a non-zero flammable mass for late explosion results, the 

program will identify the distance for each Scenario or Weather at which the 

flammable mass is largest (the “worst-case distance”), and will set the initial value for 

Downwind Distance to the minimum worst-case distance calculated for the various 

Scenarios or Weathers. For all other types of Scenario, the initial value for 

Downwind Distance will be set to 1 m. 

This method of setting the initial value for the distance is different from the method 

used in v6.7, so the initial appearance of a given Graph may be different from that in 

v7.0, even though the underlying results are identical. You can change the value for 

Downwind Distance in v7.0 using the Edit Settings dialog, which you open by 

clicking on Edit Settings in the Consequence tab of the Ribbon Bar. 

 

D-02366 The dialog for a Component may incorrectly show fields as not defaulted 

Description In the dialog for a material Component, the fields that are displayed on the right side 

of the dialog depend on which property is selected from the list at the left of the 

dialog. Most properties have a single input fields, but those that vary with 

temperature have more than one input field, and a special set of input fields is used 

for defining such properties (e.g. for heat capacity, and for vapour pressure). 

The numeric fields in this special set of input fields are arranged in two groups: a 

Coefficients group, and a Temperature Limits group. If you edit one of the fields in 

one of these groups so that it is no longer using the default value, and then OK the 

Component dialog and reopen it, you will find that all of the fields in that group are 

now shown as not defaulted, i.e. have no green border. This display is misleading, as 

the fields that you did not edit are still taking their values from the defaults system. 

 

D-02373 In Admin Parameters program, values set for 4th and 5th overpressure levels will not 

be cleared on upgrading a v6.7 Parameters file which does not have values set for the 

4
th
 and 5

th
 levels. 

Not applicable to Phast Lite 

Description In the Explosion Parameters, there are fields available for defining five overpressure 

levels of interest, but in both v6.7 and v7, only three levels are defined in the default 

set of Parameter values installed with the program. If you have used the Admin 

Parameters program to set values for the 4
th

 and 5
th

 overpressure levels, and you then 

use the Upgrade Phast 6.7 System Parameters option, to upgrade a v6.7 file that has 

values set for only three levels, the program will not clear the values for the 4
th

 and 5
th

 

levels, and they will keep the values that you set. This means that the upgraded values 

will not be identical to those in the v6.7 file. 
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D-02481 On upgrading a v6.7 file, Note text will not be upgraded for any Mixture with a single 

Component Selected 

Description A Mixture with a single Component selected will be upgraded to a pure Component 

(not to a Mixture), and any Note text that was defined for the Mixture in v6.7 will not 

be upgraded. 

 

D-02624 Dragging a Scenario that cannot be run with multi-component modelling between 

Equipment items can give incorrect display of greyed out nodes 

Not applicable to Phast Lite 

Description If a given storage Equipment item has multi-component modelling selected for the 

modelling of mixtures, then you will not be able to run any Time-varying, User-

defined or Spill Scenarios for that Equipment item, and any such Scenarios that are 

present under the item will be shown as greyed out in the Study Tree. If all of the 

Scenarios under a given Equipment item are greyed out for this reason, then the 

Equipment item itself should also be shown as greyed out. However, if you drag a 

greyed out Scenario from an item with MC modelling to one with PC modelling, the 

program will not update the display of the nodes correctly, and all will be shown as 

greyed out after the move, when instead they should all be shown as enabled. 

 

D-02710 Changing the selection of Scenarios and Weathers for running does not cause the 

Save option to become enabled 

Description When you save a workspace file, the Save option will become disabled in the Ribbon 

Bar and in the Quick Access Toolbar at the left of the title bar. It will become enabled 

again if you make a change to the input data or results (e.g. if you add a new 

Scenario, or run calculations). However, the option will not become enabled if you 

use the Exclude from calculations or Include in calculations option in the right-click menu 

for a Scenario or Weather to change the selection of Scenarios or Weathers for 
running. If this is the only type of change you have made to the file since the last time 

you saved it and you want to save these changes, you must use the Save As option in 

the File tab of the Ribbon Bar. 

 

D-02715 In a Report View, the navigation features and other buttons may be disabled 

Description Sometimes, when a Report View first opens or when you have been moving between 

the tabs in the Report, you might find that the navigation features or other buttons in 

the toolbar are disabled. 

In this situation, you can always enable the features either by clicking on an entry in 

the Group Tree, resizing the Group Tree panel, or adjusting the Zoom Control. 

Clicking on an entry in the Group Tree will move you to the page of the Report 

associated with that entry, so if you want to stay on the same page in the Report, it is 

usually easier to use resizing the Group Tree panel or adjusting the Zoom Control as 

the method for enabling the buttons in the toolbar. 
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D-02786,  

D-02944 

Changing the selection of Material for a Standalone Equipment item may make the 

process conditions for Bleve Blast Scenarios invalid 

Description For a standalone Bleve Blast Scenario, the process conditions are set in the dialog for 

the Scenario, but the material is set in the dialog for the Standalone Equipment item 

above the Scenario. 

If you edit the Equipment item and change the selection of material, the process 

conditions set for Bleve Blast Scenarios may no longer be valid with the changed 

material, e.g. the pressure or temperature set for the Scenario may be above the 

critical conditions for the changed material. In this situation the Scenarios will be 

shown in the Study Tree as having input data out of range, and when you open the 

dialog for one of the Scenarios there will be an additional “Error checker” tab in the 

dialog, which displays the process condition fields and shows which is out of range. 

After you have corrected the value in this tab, the Error checker tab will disappear, 

the Scenario will be shown as in range, and you will be able to run the Scenario 

successfully. 

 

D-02906 Storage Scenarios inserted using the Grid View will be inserted under the first 

Pressure Vessel under the selected node, not under the first Atmospheric Storage 

Tank. 

Not applicable to Phast Lite 

Description If the node that is selected in the tree is not the immediate parent for the item you are 

adding using the Grid View, the new item should be added under the first suitable 

parent node that is present under the selected node, reading down the tree. For 

example, if the selected node is a Study, and this Study contains three Pressure Vessel 
Equipment items and three Standalone Equipment items, then if you add a Leak using 

the lower grid, the new Leak will be added under the first Pressure Vessel, since this 

is the first suitable parent for a Leak object, reading down the tree structure. 

However, if the Study contains a mixture of Pressure Vessel items and Atmospheric 

Storage Tank items, with an Atmospheric Storage Tank as the first item under the 

Study, and you use the Grid View to add one of the types of storage Scenario that is 

common to both types of item, the item will be added under the first Pressure Vessel 

instead of under the Atmospheric Storage Tank, even though the Atmospheric 

Storage Tank is the first suitable item under the selected node. 

 

D-03061 On upgrading standalone Pool Vaporisation Models with continuous spills defined, 

the mass inventory on the Atmospheric storage tank Equipment item will be set to the 

spill rate, not the total mass spilled. 

Not applicable to Phast Lite 

Description If you upgrade a v6.7 file with standalone Pool Vaporisation Models, each Model 

will be upgraded as an Atmospheric storage tank Equipment item with a Spill 

Scenario underneath. For a continuous spill, the Mass inventory value for the 

Equipment item will be set to the value for the spill rate (e.g. to 5 kg, if the spill rate 

is 5 kg/s), rather than to the total mass spilled. However, this will not affect the 

calculations, as the modelling uses the Release rate and Duration of discharge 

values set in the Scenario tab section for the Spill Scenario, and does not use the 

inventory value set on the Equipment item. 
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D-03123 System Mixtures only available for selection for an Equipment item if the Mixture has 

been inserted in the Materials tab in the workspace. 

Description If you have Mixtures defined in the System Materials, these Mixtures will only 

appear in the Materials list in the dialog for an Equipment item if you have inserted 

the Mixtures in the Materials tab for the workspace. 

When you select the Insert > Mixture option in the Materials tab, an Insert Mixture 

dialog will appear, listing all of the System Mixtures that are defined in the System 

Materials. To insert a System Mixture, set the Insert option to Existing System 
Mixture from the list below, select the Mixture from the list, and then click on OK 

to insert the Mixture as a copy of the System Mixture.  

 

D-03148 Some types of report will not be produced for a Scenario if the material selected for 

the Equipment item has a name with more than 50 characters. 

Description If any of the Components or Mixtures in your workspace have names longer than 50 
characters, then some reports will not be generated properly for Scenarios that 

involve these materials. The Report View will include tabs for the reports, but the 

report will not contain any data. 

To ensure that all relevant reports are produced, you should make sure that all 

materials in your workspace have names with fewer than 51 characters. 

 

D-03189 Time-varying releases tab section is present in dialog for storage Equipment Items in 

Phast Lite, although time-varying discharge modelling is not available in Phast Lite 

Description The dialog for the Pressure Vessel and Atmospheric Storage Tank Equipment items 
includes a tab section called “Time varying releases”. This tab section contains fields 

used in time-varying discharge modeling, which is not available in Phast Lite. Most 

of the fields will always be disabled in Phast Lite, as they are only enabled when a 

time-varying Scenario is present under the Equipment item, and these Scenarios are 

not available in Phast Lite. 

 

D-03192 The Outdoor direction field is sometimes enabled in the dialog for a Catastrophic 

rupture Scenario, though it is not relevant to the calculations 

Description The Scenario tab in the dialog for a Catastrophic rupture Scenario includes an 

Outdoor direction field. This field is not relevant to the Catastrophic rupture 

Scenario and the field is usually disabled. However, there are some situations in 

which the field becomes enabled, e.g. when a Short pipe Scenario is present under the 

same Equipment item as the Catastrophic rupture Scenario. This enabling should not 

be taken to imply that the field will be used in the calculations for the Scenario, as it 

is never relevant to this type of Scenario. 

 

D-03211 An error message is written to the Output View if you increase the Volume inventory 

value for a storage Equipment item. 

Description If the option to Specify volume inventory is selected for a storage Equipment item 

and you increase the value for the Volume inventory, an error message will be 

written to the Output View saying that the new value for the volume inventory is 

greater than the upper error limit, although the dialog will not show the field as out of 

range. The message is a side-effect of checks on fields in the Time-varying releases 

tab. It does not indicate a real problem with the value and will not prevent any 

Scenarios from running. 
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SI 8519 Dialogs cannot display all the text with some display settings 

Description This can happen if the DPI (dots per 

inch) setting field in the Display 

Advanced Settings is set to 120 or 

another large value instead of to 96. 

This confuses the display of the 

dialogs so that part of the window will 

not be displayed and the mouse will no 

longer work on the OK and Cancel 
buttons.  

The workaround is to set the dots per 

inch setting back to 96, as shown. 

 

SI 10044 Premature termination for time-varying vapour line ruptures 

Description This bug is not new and was also present in previous Phast releases. 

For some vapour line rupture scenarios, the calculations terminate far too early, 

resulting in a discharged mass that is far too small. No warning or error is issued to 

inform the user about the problem. 

Pure vapour line ruptures are modelled in two regimes: Regime 1 models the 

propagation of the front from the rupture plane to the upstream end of the pipe, 

typically of relatively short duration. Regime 2 then models the depressurisation of 

the vessel. In some cases, there is an inconsistency in thermodynamics between 

regime 1 and 2, and subsequently the model terminates prematurely at the start of 

regime 2. 
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Making the most of the documentation 

Phast is supplied with a wide range of information, which should enable you to find answers to most 

of the questions you may have about the program. 

Most of the information is supplied in the form of password-protected *.PDF files. You can obtain the 

password for these files by contacting DNV Software Technical Support at 

software.support@dnv.com. 

Phast v7.0 compiled Help 

The Online Help for Phast v7.0 is in the form of a *.chm file—a compiled HTML Help file. The file 

will be installed with the rest of the Phast files when you install the program, and you will normally 

access it using the Help menu, but you can also open and read the file directly. 

In order to read the files, you must have Microsoft Internet Explorer Version 7 or later installed on 

your PC, although it does not have to be your default browser. You must also have some additional 

files that are specific to Microsoft HTML Help; these are installed automatically during the Phast 

setup process, so you should be able to read the files directly if you have already installed Phast. 

You may notice that the “?” Help button in the title bar of a dialog is no longer available. For help on a 

particular dialog you should use the “Help” button or press F1. In both cases you will be shown 

context-sensitive help relevant to the particular dialog and tab that you are looking at.  

Phast v7.0 Release Notes 

These Release Notes are supplied in *.PDF form, for future reference. 

Technical Reference 

The Technical Reference subfolder contains *.PDF documents which give details of model theory 

and also include verification and validation. 
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Setting up and managing an analysis 

Managing workspaces 

Some general points: 

• You should always save your workspace before you run any calculations. This will ensure that 

you do not lose any changes that you have made to the input data in the unlikely event that a 

condition emerges in the calculations that means that the program must be terminated. 

• It is unwise to give the same name to more than one Scenario in a given workspace, Phast will 

allow you to do this, but you will find it difficult to distinguish between the results for the 

Scenarios in Reports and Graphs, and it is not good practice. 

• You should use only letters, numbers and underscores (_) in the names of workspace files, and 

should not use special characters such as commas or quotation marks. 

Memory management 

Phast can use a lot of memory (RAM) when running very large workspaces, and also when viewing 

large combinations of Reports and Graphs. You should follow these simple rules to avoid problems 

with memory: 

• Close all out-of-date Reports and Graphs if you are no longer using them. You can always 

reopen the Report or Graph for the Scenario if you need to view it again. 

• For very large workspaces (for example those containing more than 100 Scenarios and 3 

associated Weathers) ensure before you run that you have sufficient hard disk space for 

temporary file storage and also for runtime memory requirements. 

Runtime memory is memory which will be used by Phast for storing results as it performs its 

calculations; it is a combination of fixed RAM plus “virtual” (hard disk substitute) memory. You can 

adjust the total available memory size using the System option in the Control Panel. Consult your IT 

professional before altering any of these settings. 

During calculations for a very large workspace, you may see an "out of memory" message (or similar) 

appear on the screen. If this occurs it is important you stop the calculations immediately and save your 

work. If you do not stop the calculations, Phast may crash, and you will lose any changes you made to 

your workspace since the last time you saved your work. 

The application is a single-thread software and increasing cores or CPUs will not improve calculation. 

However, multi-cores would benefit the overall user experience as the OS, Outlook, SQL Server or 

other applications can use the other system capacities. In this case, the bottleneck may be the RAM or 

disk read/write speed (local or remote).  
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